Instrukcja obslugi programatora
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MK II Eco
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UWAGA!! Programator AVR PROG USB v3 domySlnieustawiony jest
do pracy sSrodowisku BASCOM i AVR DUDE. Jesli programator ma
wspolpracowa¢ ze sSrodowiskiem AVR Studio, nalezy przelaczy¢
zworke nr 2 (DU/ST) na pozycje ON
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1. Programowanie w sSrodowisku BASCOM i AVR DUDE

a) Instalacja sterownikow

UWAGA!! przed pierwszym podlaczeniem programatora do komputera, nalezy
najpierw zainstalowac sterowniki AVRJungoUSB

http://www.andtech.pl/MKII/AVRJungoUSB.exe

Do potaczenia programatora z komputerem wykorzystywany jest przewdd mini USB
(popularny w telefonach komérkowych i aparatach). Zalecane jest korzystanie z przewodu o
dtugos$ci 1.8m lub mniejsze;j.

Potaczenie z uktadem programowanym zapewnia tasma zakonczona z obu stron wtykami
IDC-10. Rozktad pindw umieszczony jest na programatorze. Po podtaczeniu programatora, system
powinien sam wykry¢ 1 zainstalowa¢ odpowiednie sterowniki. Jesli zainstalowat si¢ poprawnie, w
Menadzerze urzqdzen powinno znalez¢ si¢ urzadzenie Jungo z dwiema zaktadkami: AVRISP mkII
oraz WinDriver.. Menadzer urzadzen dostepny jest w Panel sterowania > System >zaktadka Sprzet.

[+ Klawiatury

41 ' Kamputer

+- 9. Kontralery déwicky, wideo i gier

+1 4= Kontrolery IDE ATAATAPI

=4 Kontrolery stacii dyskietek

§ Kontrolery uniwersalnej magistrali szeregowej
& Monitary

“) Mysz i inne urzadzenia wskazujace
- Porty (COMiLPT)

| o8 Procesory

5 Stacje dyskietek

e Stacje dyskow

s Stacie dyskdw CD-ROMIDVD

=8 Urzadzenia do obrazowania

S A R

4|

[+ #+

UWAGA!! W przypadku, gdy programator zostal pomyslnie zainstalowany przez
system operacyjny (Windows), Swieci si¢ na zielono dioda. Jesli tak nie jest, prosze
podlaczy¢ go bezposrednio do PC lub laptopa z pominieciem HUBGw i stacji dokujacej.
W niektorych sytuacjach, urzadzenia te uniemozliwiaja poprawna prace
programatora.
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Nastepnie nalezy pobra¢ aplikacje LibUsbDotNet_Setup.2.2.8
http://www.and-tech.pl/MKII/LibUsbDotNet Setup.2.2.8.exe

Po akceptacji licencji oraz wybraniu $ciezki instalacji, powinni$my zobaczy¢ okno, przedstawione
na [lustracji 2. Wybieramy wytacznie pierwsza pozycje — Runtime Files 1 klikamy Next.

15 Setup - LibUsbDotNet
Select Components

‘which components should be installed?

Select the companents you want ta install; dear the components you da not want to
install. Click Next when you are ready ko continue.

[Custom Installation

(@ Runtime Files 2,7 M8
D Source and Example Code 3,2MB

Current selection requires at least 5,0 MB of disk space.

{ < Back ” Next > _][ Cancel

Tlustracja2

Zaznaczamy Install libusb-win32 with filter capabilitied? podobnie jak na Ilustracji 3 1 klikamy
Next.

18 Setup - LibUsbDatNet

Select Additional Tasks
‘Which additional tasks should be performed?

Select the additional basks you would liks Setup to perform while instaling
LibUsbDotMet, then click Mesxt.

libush-win
Install ibusk-win32 with filker capabilities?

[ < Back “ NextF{ Cancel J

llustracja 3

8 Setup - LibLsbDotNet EoE

Completing the LibUsbDotNet
Setup Wizard

Setup has finished installing LibUshbDothet an your computer,
The application may be launched by selecting the installed
icans,

Click Finish to exit Setup.

Launch Filter installer wizard

llustracja 4

Instrukcja obstugi programatora AVR Prog USB v2 / MK II ECO Strona 4
www.and-tech.pl


http://www.and-tech.pl/MKII/LibUsbDotNet_Setup.2.2.8.exe

Uruchamiamy program Filter Wizard. Jest dostepny pod $ciezka: Start->Programy->LibUsbDotNet-
>libUsb-win32->Filter Wizard.

@ Okresl dostep do programdw i ich ustawienia domysine

'E\;‘; Windows Catalog

% Windows Update

) Proaramy i @ InsERT ’
I) Zebra Technologies  »
Dokumenty | @ Internet Explorer
B4 Pairt.NET
Ustawisnia D|E
Iw Mozilla FireFox
Wyszukaj » @) Flip3.4.3 »

) Hyparsnap 6
1) Gadwin Systems
@ LibtsbDothet
'!‘3 MCS Electronics »
¥

Pomoc i obstuga techniczna

Urucham...

# LbUsbDothet Help
¥ Test Device Notify |38 Inf-wizard
E Test Info

§5! Uninstall LibUsbDotMet
T USE Infwizard

Wyloguj: RAFAL...

Witacz komputer., ..

BE e LR

| Windows XP Professional

Mlustracja 5

W oknie Install/Remove Device Filter(s) wybieramy pierwsza pozycje Install a device filter-
[lustracja 6.

Infarmation

This program adds/remaves libush-win32 as a driver to an existing device
installation.

The libusb-win32 filter driver allows access to ush devices using the libusb-win32 api
while maintaining compatibility with software which uses the ariginal driver.

InstalliRemove Device Filter{s)
(3) Install a device filter
O Remove a device filter

O Remove all device Filters

% [ Mext = ] [ Cancel J

llustracja 6

W kolejnym oknie nalezy zaznaczy¢ urzadzenie AVRISP mklIl, podobnie jak na Ilustracji 7.
Device Selection
Connect vour device and select it from the list of unfiltered devices below. If your

device isn't listed, it may already be fikered, be in a "driverless” state, or
incompatible with the libusb-win32 fileer driver.

Hardware ID Description M
vid:203a pid:Fffc rev:0100 mi:01 Urzgdzenie USE interfejsu HID =l
wid:203a pid:Fffc rev:0100 mi;00 Urzgdzenie USE interfejsu HID (sl
wid: 203a pid:Fffc rev:0100 Urzgdzenie kompozytowe USE (sl

wid:203a pid:Fffb rev:0100 Urzgdzenie LSE interfejsu HID (sl

AVRISP mkIl

£ |

|

Pyl

llustracja 7
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Po nacis$nigciu przycisku Install powinnismy zobaczy¢ nastgpujace okno:

\l‘) libusb-win32z device filker successfully installed For AYRISP mkII {usbivid_03eb&pid_2104&rev_0200)

N
llustracja 8
Programator zostat poprawnie zainstalowany.
Instrukcja obstugi programatora AVR Prog MKII
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b) Konfiguracja:
1. BASCOM

UWAGA!!

AVR Prog MKII jest wspierany przez BASCOM w wersji 2.0 i wyzszych. W przypadku
nizszych wersji nalezy skorzysta¢ z zewne¢trznego programu, np. AVRDUDE.

Aby programator wspolpracowat ze srodowiskiem BASCOM, nalezy go odpowiednio
skonfigurowa¢. W tym celu, uruchamiamy program BASCOM i przechodzimy do ustawien
programatora — zaktadka Options >Programmer. Z wysuwanej listy Programmer wybieramy
pozycje USBprog Programmer / AVRISP mklI (Ilustracja 9).

BASCOM-AVR Options

Compie | Commuication | Evioangnt Sivultor | Frogianer | onitor | Prtr|
Programmer USBpla_nggrm £ BVR ISP il g
Play sound
[ Ersse waming TauoFas [ AutcVeiity [ Upload Coda and Dats
[ Program after compla [T Setfocus to terminal emuiaton after programming
Almel
COMpot (oo v [Doret set 15P clack fequency
Clock (125000 v|  CIAVRISP potocol
Timeout USE 1B g Ous
Timeout Serial 100 [i4]
| Programmsr Options.
o] (xoimme

llustracja 9

Nastepnie zaznaczamy opcje USB i1 klikamy OK.

Emmhs_ Communication Ervioreent | Simulstes| Programmer  Mordor - Prinket |
Progatrenes USBprop Proprammne: / 8VR ISP will ~|
Flay sound |
T Erase wairmng [ Aute Flach AuloVely [] Upload Cade and Data
] Program atver compile ] Set focus to terminal emulalor after progiamming
Al
COM port comi v  [JDonotsetISP clack frequoncy
Clock 125000 v CIAVRISP peotocol
Tameou USB (100 g (Euse
Timeout Sesal m—@
o] [ comonl] &

llustracja 10

Programowanie uktadu odbywa si¢ po kliknigciu w ikone Program chip.
% BASCOM-AVR IDE [2.0.7.1] - [C:\Documents and Settings\Operator\Pulpit\PRAKTYKIKURSY\RARKo dy_2\kod3. bas]

e Ble Edk Wiew Frogam Took Qptions  Window  Help

P HBLREA. kB4 0aee@)0n. iemn.io 2 (FE
kodlbas &2
Sub v Label -
ISrestile = "nbtdpdet .dat” ‘dla procesora ATHegatddp
‘$regfile = "alzdef.dat” ‘dla procesora ATMegald: |
$regfile = "nlédef . dat” 'dla procesora ATHegalé

Scrystal = 16000000

Do

'poczatek petli

Set FORTE. 0

‘gasiny diede

‘dioda w naszyn zestawie zafvieca sig po podaniu na jej wyprowadzenie stanu n‘_s}:je-j:
Vait 1 czekany 1s

€

Tlustracja 11
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Okno programowania przedstawia [lustracja 12.

¥ Elektor 7 mikil compatible Programmer

Fle Bufter Chio 2
2 He aTTTSRE.
e 77 Flshsce  OKB EEFROMsize [0 Bytes

EPAOM | Lock and Fuse bits

{mlozjoajm|ns|us|w 08 |09 04| 08 C(Z!EOIEE EFI |

94 0C 00 24 % 18 00 005 18 00 0095 18 0000 =%
95 18 00 00 95 18 00 00 95 18 00 00 95 1800 00 =..
95 18 00 00 9 18 00 00 95 18 00 00 95 18 00 00 =.e.=
95 18 00 00 95 18 00 00 95 180000 95 18 00 00 =..
95 18 00 00 95 18 00 00 95 18 00 00 95 18 00 00 ».e. .=
95 18 00 00 ES &F BF 80 E3 CB E2 €0 2€ 4E EO 04 -.[22TECSENE.
BF BE E0 D4 E0 F4 2E 5 95 A8 B7 84 2£ 08 7F 87 &20f_ ..t
BF B84 EY €8 27 93 BD @1 BD 91 EF EE 0 F3 E6 AD 24" 1"difde
E0 BO 27 €8 93 €0 97 31 F7 E9 24 66 94 CO EO E1 FTT-1+48tiR14
E0 FO 94 0E 00 54 98 CO EO E1 EO FO 94 0E 00 54 (& TIRfsE-.T
94 OC 00 46 S4 FB CF FF EE |88 EO0 93 DO OC 97 |31 =P r -
F7 D99 08 97 31 F7 F1 9 08 94 68 FB 62 95 08 «0s~Terie "hibe.
94 EB FB 62 95 08 93 EF 93 FF 27 EE 2B E0 28 E9 "&fbe"d" T+ieé
FO 31 EAEQ EO FF 97 31 F7 F1 97 01 F7 D1 91 FF dlgff —1+fm 0"
91 EF 9 08 de.

8]

=)

[2]s]2|5|8||3|8|2|5]8|s)

m
=

B C\Documents and Seltings\Dperator\ Pulst\ PRAKTYKINKURSY\RAR \kody_2\KOD3 EEP nat found.

O C\Documents and Seltings\Dperator\Pulplt\PRAK TYKINKURS \RAR kedy_2\K0D3 BIN loaded 228 bites into FLASH buffer
© Elekior 7 bl compaible programmer sst

O Stated

Hlustracja 12

Zaktadki Flash, EEPROM i Lock and Fuse bits umozliwiaja podglad kolejno pamigci FLASH,
EEPROM i fuse bitow procesora po zaprogramowaniu.
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2. AVR DUDE

W celu korzystania ze srodowiska AVRDUDE nalezy pobraé
avrdude-5.8-w32_avrdude- GUI _1.0.5

http://www.and-tech.pl/MKIl/avrdude-5.8.zip

Po wypakowaniu wiaczamy graficzny interfejs: avrdude-GUI exe 1 nastgpnie w oknie Programmer
wybieramy Atmel AVR ISP mkll (avrispmkll), w oknie Port — usb, w oknie Device — model

procesora, ktory chcemy zaprogramowac. Podobnie jak na ilustracji 13.

Przycisk Read stuzy do odczytu, Write — do zapisu, Verify — do weryfikacji pamieci procesora.

Guzik Erase — Write — Verify kolejno czys$ci, zapisuje i weryfikuje pamig¢ procesora.

avrdude-GUI [yuki-lab.jp Version 1.0.5]

avrdude. exe File

avrdude. exe D

Frogrammer

[] Display ‘Window

Atrel AYR ISP mkll (avtispmkll)

Device

\ATmega16 (m16)

Command line Option

Fuse Flash

hFuse I: h | |E
IFuse ’— h l Read J [ Write l

eFuse | h | Write ] l Verify J [ Erase - Write - Verify l

Lock Bit EEPROM

| | =
\— n [ Write ] [ Read ] [ Write l
[ ]

llustracja 13
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http://www.and-tech.pl/MKII/avrdude-5.8.zip

2. Programowanie w Srodowisku AVR Studio a) Instalacja sterownikéw

UWAGA!! przed pierwszym podlaczeniem programatora do komputera, nalezy najpierw
zainstalowac sterowniki AVRJungoUSB.
http://www.and-tech.pl/MKII/AVRJungoUSB.exe

Do podfaczenia programatora z komputerem wykorzystywany jest przewod mini USB (popularny
w telefonach komorkowych i aparatach). Zalecane jest korzystanie z przewodu o dlugosci 1.8m lub
mniejszej. Potagczenie z uktadem programowanym zapewnia ta$ma zakonczona z obu stron wtykami
IDC-10. Rozktad pindw umieszczony jest na programatorze. Po podtaczeniu programatora, system
powinien sam znalez¢ i zainstalowa¢ odpowiednie sterowniki. Jesli zainstalowat si¢ poprawnie, w
Menadzerze urzgdzen powinno znalez¢ si¢ urzadzenie Jungo z dwiema zaktadkami: AVRISP mkll
oraz WinDriver. Menadzer urzadzen dostepny jest w Panel sterowania > System >zaktadka Sprzet.

[+ Klawiatury

41 Komputer

+- ), Kontrolery déwieku, widso i gier
+1 4= Kontrolery IDE ATAMATAPI

£

| (=4 Kontrolery stacii dyskietek

3 § Konkrolery uniwersalnej magistrali szeregowej
F _'; Monitory

J Mysz i inne urzadzenia wskazujace
- Parky (COMiLPT)

-] Procesory

A Stacie dyskistek

“e Stacje dyskow

b Stacie dyskdw CD-ROMDVD

=24 Urzgdzenia do obrazowania

3 [F-E-E

# [+ +

llustracja 14

UWAGA!!

W przypadku, gdy programator zostal pomyslnie zainstalowany przez system
operacyjny (Windows), Swieci si¢ na zielono dioda. Jesli tak nie jest, prosze podlaczy¢
go bezposrednio do PC lub laptopa z pominieciem HUBOw i stacji dokujacej. W
niektorych sytuacjach, urzadzenia te uniemozliwiajg poprawng prace programatora.
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http://www.and-tech.pl/MKII/AVRJungoUSB.exe

b) Konfiguracja

W celu konfiguracji nalezy wiaczy¢ program AVR Studio. Opcje programatora sg dostepne w
zaktadce Tools->AVR Programming. (Ilustracja 15).

File Edt View WAssitX FProject Debug Tools | Window Help
iS4 o 2 LR Love

IPMERHE F 0 s

n

i AVR Programning Dz ex ==

G AddSTREUT

AVR QTouch Studa

Cade Snippets Manager... el Chri4E
Addin Manager.
il Extension Manager...
External Tooks. .
Iport and Export Settings. .
Customize

Options. .,

Mlustracja 15

Z rozwijane]j listy Tool nalezy wybra¢ programator AVRISP mkII. W zaktadce Device okresla si¢
model procesora, ktory chcemy programowac a nastepnie przyciskiem Apply zapisuje si¢
ustawienia.

AVR Programming, E"z]

Tool Device Interface Device ID Target Yolkage

v |IsP v| Apply ' not read

llustracja 16

Przycisk Read odczytuje numer procesora i napigcie programowanego obwodu.

AVRISP mkll (0000A00128255) - AVR Programming @@
Taol Device Interface Device 1D Target Voltage
AVRISP mkIl + | ATmegalé ML ‘l]xlEl:le‘! 0x03 | S,0%
Interface settings ISP Clock
Tool infarmation 125 Kz
Devics information -
The ISP Clock frequency must be lower than 1/4 of frequency the device is operating on.
Memaries
Lock bits
llustracja 17
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AVRISP mkll (000DAOD128255) - AVR Programming

Interface settings
Tool information

Device information

Tool Device Intetface

Device ID Target Yokage

AYRISP mkIl "j ATmegalf « MISP vl

| Ox1E Dx94 0x03 \ | sov \

Device

[#] verify device after programming

W zakladce Memories programuje si¢ pami¢¢ procesora.

llustracja 18

Instrukcja obstugi programatora AVR Prog USB v2 / MK II ECO
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3. Aktualizacja wsadu programatora

Programator AVRISP mkll posiada domyslnie wsad obstlugiwany zaréwno przez srodowisko
BASCOM, AVR DUDE oraz AVR Studio.

Mozliwa jest rowniez aktualizacja oprogramowania poprzez zlacze USB programatora.

Aby zaktualizowa¢ programator potrzebny jest program FLIP:
http://www.and-tech.pl/MKII/FlipInstaller-3.4.5.106.exe

Postepuj zgodnie z tg instrukcjg w celu wystania nowego oprogramowania do programatora
przy pomocy FLIPa.

Zainstaluj program FLIP, a nastgpnie przelacz 4 switch do pozycji ON a nastepnie OFF,
znajdujacy si¢ na programatorze, w celu wprowadzenia AVRPROG MKII w tryb
bootloadera — sygnalizowany zgasnigciem zielonej diody.

o Al

Ten kreator pomaga zainstalowad cprogramowanie dla:

ATI0USE162 DFU

L'J Jesli do sprzgtu dotgczony byt instalacyjny
7 dy<k CD lub dyskietka. whdz ten noénik leraz.

Co cheesz, aby ziobit kreator?

O Zainstaluj oprogramowarie automatycznie (zalecane)

(& Zamnsztaly z listy lub okreslone) lokalizac) [zaawansowane]

Klikrij przycizk Dalej. aby kontyruowac:

[ < Witecz M Dalej > ] [ Arualuj

llustracja 19
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http://www.and-tech.pl/MKII/FlipInstaller-3.4.5.106.exe

Nalezy wybra¢ opcje Zainstaluj z listy okreslonej lokalizacji (zaawansowane) 1 podac
lokalizacje przedstawiong na Ilustracji 20 - Program Files / Atmel / Flip 3.4.3 / usb.

Przegladanie w poszukiwaniu folderu iil[l_d
‘Wbierz folder, khdry zawiera sterowniki dla sprzetu.
[=) <@ Dysklokalny (C:) L
2 dell
[+ | ) Documents and Settings
1) drvrtmp
= () Program Files
) Adobe
# () Analog Devices =
= ) Atmel
# ) AYR “Jungo USE
# [ FLIP 24,6
= I Fip3.4.3
# ) bin
# | 3) demo
# ) help
[ info
=0
) amde4
) la64
=+ | J) UpdateDriver
= =88 7
by wyswietlic podfoldery, kiknij powyze] znak plus.
[ o [ anuwi |
llustracja 20
Kliknij OK i uruchom program FLIP.
~eixd
Fle Buffer Device Settngs Help
o 32
Y Y LY
-Operations Flow - FLASH Buffer Information ATI0USB162
o i | Sitmatiire Byte-:l_l_l—l_
@ Fi= Size 12KB
it | Device Boot Idsl—l_
r o Checksum OxEE
@ [ Blank Check =
Reset Before Loading |Basduacss far I
@ ¥ Frooram HEX File:
9 [F Verify
ATMEL
om Select EEBROM | St et | [ Reset
| | Commurication OFF
llustracja 21
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Nacis$nij ikone Select device (symbol chipa) lub opcje w menu Device — Select i nastepnie
wybierz urzqdzenie z listy (at90usb162) — llustracja 22.

Device Selection x|

9 Select a device
\{f) S ——

ATIOUSEE4E
ATI0USELS T
ATI0USES2

ATmegal 6U2
ATmegaléld
ATmega3zlUz
ATmega32ii4
ATmegaizUs
ATmegasl2 =]

0K I Cans:all

Mlustracja 22

=

Teraz kliknij na ikone¢ Select communication (symbol przewodu USB) 1 wybierz USB.
x|

Close I Cancel I

Nacis$nij Open.
: e

File Buffer Dewice Settings Help

PS LLATH T D

- Operations Flow FLASH Buffer Information - ATIOUSB162
Signature Bytes ]53 |1 E |94 EEZ
Size  1Z2KB
@ [V Erase
P. =
el Device Boot 14500 [on
Checksum 0xFF
@ [ Blank Check
Reset Before Loading Bootloader Ver. II.D.S
@ [V Program HEX File:

@ [ verify
AIMEL
Run Select EEPROM ] Start Application | [V Reset
| ' |use on
Hlustracja 23
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FafC:\ AVR Stuff\LUFA\LUFA100209' Projects', AVRISP-MKIT\AVRISP.hex
Eile Buffer Dewvice Settings Help

=loix|

#S LIHTH T B

~Operations Flow FL&SH Buffer Information ~ATI0USE16Z
. S Signature Bytes Iga } E [94 I82
Q W Erase e &
Range 0x0 - 0x24FS
g Device Boot Ids |00 Fli]
Checksum 0123409
@ [ Blank Check
Reset Before Loading Bootloader Ver, [1.0.5
O 7 Program HEX File: AVRISP.hex
9462 util bytes
QO ¥ verify m
EETE—
e Select EEPROM | Skart Application I [~ Reset
| verify PASS iusa ON
llustracja 24

Zataduj pobrany wczesniej nowy wsad hex (101116 AVRISP studio.hex ) naciskajac ikong
LOAD hex file lub poprzez menu File > LOAD HEX File... Po wybraniu pliku wsadowego,

nacis$nij guzik RUN w dolnym lewym rogu.

GOTOWE! Twoj programator zostal zaktualizowany.

Kliknij Start Application aby zrestartowac programator.

Instrukcja obstugi programatora AVR Prog USB v2 / MK II ECO
www.and-tech.pl

Strona 16



4. Obsluga programatora

Programator wyposazony jest w 10 pinowe zltgcze ISP w standardzie KANDA. Ponizej znajduje si¢
opis sygnatow w zlaczu.

GND
GND
GND
GND
VCC

Funkcje przelacznikow programatora:

Przetacznik 1 — Targ. VCC
W pozycji ON na pin VCC oraz bufor podane jest zasilanie +5V z portu USB
W przypadku gdy programowany oktad zasilany jest napigciem 3.3V przetacznik 1- Targ.
VCC musi by¢ w pozycji OFF

Przetacznik 2 — DU/ST
W pozycji ON programator pracuje ze sSrodowiskiem AVR Studio, w pozycji OFF z
BASCOM i AVR Dude

Przetacznik 3 — NONE
Nie uzywany

Przetacznik 4 — BOOT
Przyetacznik resetu do trybu bootloadera — nalezy przelaczy¢ do pozycji ON i po Is do
pozycji OFF.
W trakcie normalnej pracy przetacznik 4 — BOOT musi by¢ w pozycji OFF

Instrukcja obstugi programatora AVR Prog USB v2 / MK II ECO Strona 17
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5. Ochrona srodowiska

Oznakowanie symbolem ,,przekreslonego kontenera na odpady” informuje o zakazie umieszczania
zuzytego sprzetu elektrycznego i elektronicznego tacznie z innymi odpadami, zuzyty sprzet
powinien by¢ zbierany selektywnie. Uzytkownik ma obowigzek przekaza¢ zuzyty sprzet do punktu
zbierania w celu zapewnienia jego recyklingu 1 odzysku, gdyz niekontrolowane uwalnianie do
srodowiska sktadnikéw niebezpiecznych zawartych w sprzecie elektrycznym i elektronicznym
moze sta¢ si¢ zrédtem zagrozenia dla zdrowia ludzi 1 zwierzat oraz moze powodowa¢ dlugo
utrzymujace si¢ negatywne zmiany w srodowisku naturalnym.
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INFORMACJA

AVRPROG MKII zostatl wsparty bibliotekami LUFA, ktore sg wydane na licencji MIT
(http://www.fourwalledcubicle.com/LUFA.php).
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